
EagleFiler 1.0 Manual

Michael Tsai

c-command.com

October 13, 2006



Contents

1 Introduction 4
1.1 Importing Is a Snap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.2 Familiar Mail-like Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.3 Search Everything . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.4 The Library Is Open . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.5 Reliable Data Storage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.6 Add Tags and Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.7 Speed Up and Simplify Your Other Applications . . . . . . . . . . . . . . . . . . . . 6
1.8 Multiple Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2 Installing and Updating 7
2.1 Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.2 Updating From a Previous Version . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.3 Installing EagleFiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.4 Uninstalling EagleFiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

3 Importing 8
3.1 What Can Be Imported . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
3.2 Ways to Import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
3.3 Don’t Make Changes While Importing . . . . . . . . . . . . . . . . . . . . . . . . . . 10
3.4 Writing Capture Scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4 Browser Windows 12
4.1 Source List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
4.2 Records List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
4.3 Record Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
4.4 Searching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

5 Menus 15
5.1 The EagleFiler Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

5.1.1 About EagleFiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
5.1.2 Software Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
5.1.3 Purchase . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

5.2 The File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
5.2.1 New Library. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
5.2.2 New Folder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.3 New Rich Text File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.4 New Browser Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.5 Open Library. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.6 Import URL(s). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.7 Import File(s). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.8 Export. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.9 Empty Trash. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

5.3 The Edit Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

2



5.3.1 Undo/Redo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
5.3.2 Copy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
5.3.3 Copy URL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
5.3.4 Copy Source URL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

5.4 The View Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.1 Message . Raw Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.2 Message . Plain Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.3 Previous/Next Record . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.4 Select Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.5 Open in External Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.4.6 Open in New Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

5.5 The Record Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
5.5.1 Mark Unread/Read . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
5.5.2 Flag/Unflag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
5.5.3 Show Inspector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
5.5.4 Show Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
5.5.5 Verify . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
5.5.6 Merge Mailboxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.5.7 Open Source URL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.5.8 Open in del.icio.us . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.5.9 Reveal in Finder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.5.10 Reply to Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5.6 The Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.6.1 Activity Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
5.6.2 Drop Pad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
5.6.3 Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.7 The Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
5.8 The Dock Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

6 Preferences 23
6.1 Capture Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
6.2 Fonts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
6.3 Quoted Text Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

7 Frequently Asked Questions 26
7.1 Why doesn’t my serial number work? . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

8 Legal Stuff 26

9 Version History 28

3



1 Introduction

EagleFiler makes managing your information easy. It lets you archive and search mail, Web pages,
PDF files, word processing documents, images, and more. Use it to collect information from a
variety of sources. Browse different types of files using a standard three-pane interface. Organize
them into folders and annotate them with tags and notes, or leave everything in one folder and
pin-point the information you need using the live search. Since EagleFiler stores its library in
Finder format, you can use it in concert with the other tools in your Mac ecosystem.

1.1 Importing Is a Snap

Getting your information into EagleFiler is easy. When you’re viewing a Web page in Safari or
NetNewsWire1, looking at a mailbox in Mail, or browsing files in the Finder, just press the capture
key (F1 by default). EagleFiler will save the document into its library, and you can go right on
working without interrupting your flow. (Of course, you can also use drag and drop or other
methods if you prefer.) Once the document is in EagleFiler, you’ll always have a copy of the way it
looked when you imported it. No more bookmarking a great article, only to find out later that the
page is no longer available or that registration or even payment is now required. If you do research
on the Web, you know that pages change—sometimes without notice—so it’s always good to keep
a paper trail of exactly what you read. There’s no shame in being a digital pack rat when today’s
Macs ship with tens or even hundreds of gigabytes of storage.

1.2 Familiar Mail-like Interface

EagleFiler browser windows use a three-pane view that’s familiar to any Mail user. This is not a
database front-end; it’s a real Mac application with a fully Aqua user interface. Click on one or
more sources to view their contents. Enter some text in the search box to filter the record list.
Click on a record to view it right there in the window. HTML mail messages can be viewed as rich
text, or you can view e-mails as plain text, complete with color-coded quoted text and clickable
links. You can open as many windows as you want to view different parts of the library.

1.3 Search Everything

It’s no good to store your information if you can’t find it when you need it. Fortunately, EagleFiler
offers some powerful search options. If you know the title, author, or recipient you’re looking for,
you can search by one of those fields. Or, use EagleFiler’s indexed search to look through the entire
contents of your documents. Like Spotlight, EagleFiler can search different types of files at once—
after all, what matters is what you’re looking for, not whether it’s in a PDF, an e-mail, or a chat.
Unlike Spotlight, EagleFiler makes it easy to narrow down the results. You’re searching within the

1http://ranchero.com/netnewswire/
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library, not all the files on your hard disk, so the search is fast. You can select one or more folders
or mailboxes within the library to restrict the search—reducing the amount of data that EagleFiler
has to look through, and number of results that you’ll have to comb through. You can even do
Boolean or phrase-based searches to tell EagleFiler exactly what you’re looking for. Once you’ve
narrowed the search results to a manageable number of documents, it’s easy to find the information
you’re looking for because you can view the document contents right there in EagleFiler.

1.4 The Library Is Open

Like iTunes and iPhoto, EagleFiler keeps your data in a library. The library is just a special folder
in the Finder that EagleFiler manages. You shouldn’t re-arrange the files and folders in the library
except through EagleFiler, but other than that you can treat it just like a regular folder. Browse
its contents in the Finder or Path Finder2—the folder structure matches the folders in EagleFiler.
View and edit the files using your favorite applications. Drag key files to the Dock or make aliases
of them on your desktop. Search the files using Spotlight. Label files in EagleFiler, and the labels
automatically show up in the Finder—and vice-versa. Files in the library will still show up in your
applications’s Open Recent menus, and Preview will still remember which page of the PDF you
were reading. In short, you can capture, organize, and search your files using EagleFiler, without
giving up the normal conveniences of the Mac experience.

1.5 Reliable Data Storage

The library may look like just a folder full of files, but EagleFiler uses a Core Data3 SQL database
to keep track of the files and their contents. This lets you put thousands of files in the library and
access them reliably and quickly. Each time you open a library, EagleFiler checks to make sure
that all the files are present. It can even verify the library (using MD5 checksums4) to make sure
that none of the files has been corrupted. There’s no point in storing and backing up damaged
files. When you archive your documents in EagleFiler, you can be sure that when you need to read
them again they’ll be in pristine condition. Plus, EagleFiler libraries go great with backups and
archival. Your data is stored in individual files, so smart backup and synchronization programs
won’t waste time and space copying the documents that haven’t changed. Since the files are in
standard formats like PDF, RTF, and mbox, you’ll be able to read them years from now, even
if—alas—you’re no longer using EagleFiler.

1.6 Add Tags and Notes

Tags (like keywords in iPhoto) are somewhat like labels in the Finder, except that each record
can have as many tags as you want. EagleFiler has some tags such as “unread,” “flagged,” and

2http://www.cocoatech.com
3http://developer.apple.com/macosx/coredata.html
4http://en.wikipedia.org/wiki/Md5#Applications
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“replied” built-in, and it will import these from Mail. If you’ve created additional tags in Mail
using MailTags5, EagleFiler will import those as well. You can also create your own tags and give
each one an abbreviation symbol (which appears in the records list) and a color. Each tag has a
corresponding tag folder in the browser window that shows all the records with that tag.

Each document or message in EagleFiler can also have a note. Notes are like comments in the
Finder on steroids. They support rich text with multiple fonts, sizes, and colors. Notes can even
include clickable links, graphics, tables, and lists. Use notes to write down information that goes
with your documents, to excerpt key passages, to add your own comments or analysis, or to add
links to related records in EagleFiler.

1.7 Speed Up and Simplify Your Other Applications

Most e-mail programs are designed for communicating with your mail server and letting you read
and write messages—not for storing all your old mail. By cleaning out your mail program’s
database, you can remove some clutter from its mailbox list and speed it up. But cleaning it
out doesn’t have to mean lots of time wasted trying to predict which messages you might need in
the future. Disk space is plentiful—just archive all your old mail into EagleFiler. Later, you’ll be
able to find what you need with a quick search. Meanwhile, the archived messages will no longer
be slowing down Spotlight searches of your files and current messages.

Likewise, your Web browser’s bookmarks feature is great for remembering sites that you’ll want
to go back to frequently. But it isn’t ideal for remembering the information found on Web pages.
Don’t bookmark news articles, recipes, reviews, and other documents—and then try to look through
your overflowing bookmarks folder to recall the articles by title and URL. Instead, capture the Web
pages into EagleFiler where you’ll be able to search their entire contents.

1.8 Multiple Libraries

Some people like to dump all their information into a single EagleFiler library, with minimal folder
structure, and locate documents that they need using the search feature. But EagleFiler also
supports multiple libraries, for those who like to separate their business and personal files, group
them by project or client, or keep different kinds of files in different places. For example, you might
keep some of your files on your iPod or keychain drive, some on an encrypted disk image6, and others
in your Documents folder. However you want to group your files, EagleFiler can accommodate.

5http://www.indev.ca/MailTags.html
6http://c-command.com/dropdmg/manual-ah/protecting-your-files-w
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2 Installing and Updating

2.1 Requirements

Mac OS X 10.4 or later is required. EagleFiler is a universal binary that runs natively on both
PowerPC- and Intel-based Macs.

It is also recommended that you install Growl7 so that you get a notification each time a document
is imported into EagleFiler.

Menu Master8 (as of version 1.4.1) is not compatible with EagleFiler and will cause it to crash at
launch. To prevent the crash, open System Preferences, click on Menu Master, and add EagleFiler
to the Exclude List.

2.2 Updating From a Previous Version

The easiest way to update EagleFiler is to use the Software Update command to download and
install the latest version.

Alternatively, you can replace the old EagleFiler application file with the new one. That is, if
EagleFiler is installed in the Applications folder, drag the new EagleFiler application icon into
the Applications folder and click Replace when the Finder asks if you want to overwrite the old
version. If you get an error saying that you do not have sufficient privileges, drag the old EagleFiler
to the trash and empty it, and then drag the new one into the Applications folder.

2.3 Installing EagleFiler

Double-click the EagleFiler-1.0.dmg file to mount the EagleFiler disk image. Then drag the
EagleFiler application to your Applications folder.

2.4 Uninstalling EagleFiler

To uninstall EagleFiler, drag its application file to the trash. Although you will no longer be able
to open your libraries with EagleFiler, the files in the libraries will remain accessible in the Finder.
Next to each library is a folder called Files (which contains the files and folders in the library)
and a folder called Notes (which contains any notes that you’ve added).

7http://growl.info
8http://www.unsanity.com/haxies/menumaster
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3 Importing

3.1 What Can Be Imported

The following types of information can be imported into EagleFiler:

• Bookmarks from Safari9 and OmniWeb10, which will be downloaded and converted to Web
archives.

• Chat transcripts. iChat11 logs chats as .chat or .ichat files in the folder:

/Users/<username>/Documents/iChats

Adium12 logs chats as HTML files in the folder:

/Users/<username>/Library/Application Support/Adium 2.0/Users/Default/Logs

• Folders. EagleFiler imports the contents of the folder (and any subfolders, preserving the
hierarchy). It skips any files that it doesn’t know how to read.

• HTML files.

• Images.

• Mailboxes in mbox format and local Apple Mail mailboxes.

Apple Mail
Local mailboxes (folders whose names end with .mbox) from Mac OS X 10.4 can be
dragged directly from Mail’s mailbox list (or the Finder) into EagleFiler. Or, select the
mailboxes and press the capture key. EagleFiler will preserve the message status and
flagged indicators from Mail, as well as any keywords and notes from MailTags13. The
mail will be converted to the standard mbox format. EagleFiler cannot import IMAP
mailboxes.

Entourage
Drag mailboxes directly from the mailbox list to EagleFiler.

Eudora
Mailboxes are stored in the Mail Folder folder inside the Eudora Folder folder, and
they can be dragged from the Finder into EagleFiler. They are not actually in mbox
format (for example, the attachments are removed), but the format is close enough that
EagleFiler will be able to read most of the messages.

9http://www.apple.com/macosx/features/safari/
10http://www.omnigroup.com/applications/omniweb/
11http://www.apple.com/macosx/features/ichat/
12http://www.adiumx.com
13http://www.indev.ca/MailTags.html
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GyazMail
Select some mailboxes and choose File . Export . Unix mbox. . .. Then drag the
exported files into EagleFiler.

Mailsmith
Use the capture key to import the selected mailboxes or drag the selected messages
into EagleFiler. In Mailsmith 2.1.5, dragging mailboxes directly to EagleFiler will not
work, but you can drag mailboxes to the Finder and then drag the exported files into
EagleFiler.

PowerMail
Select some mailboxes and choose File . Database . Export. . .. After picking what
you want to export, select Unix Mailbox, and then drag the exported files into Eagle-
Filer.

Thunderbird
The mailboxes are stored in the folder:

/Users/<username>/Library/Thunderbird/Profiles/<profile>/Mail/Local Folders/

and can be dragged from the Finder to EagleFiler.

• Microsoft Word files.

• Movies.

• PDF files.

• PostScript and EPS files.

• Rich Text (RTF and RTFD) files.

• Sounds and music.

• Text files (encoded with ASCII or UTF-8, or with a byte-order-mark) and text clippings.

• URLs, which will be downloaded and converted to Web archives.

• Web archives.

3.2 Ways to Import

There are many ways to get your files into EagleFiler. You can:

• Press the capture key.

• Drag files, text, or a URL onto:

– A EagleFiler browser window’s source list.
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– The Drop Pad.

– The EagleFiler application icon.

• While viewing a document in another application, choose File . Print and then choose Save
PDF to EagleFiler from the PDF button menu. This will convert the document to PDF
format and import it into EagleFiler.

• Choose Import File(s). . . from the File menu.

• Choose Import URL(s). . . from the File menu.

• Select some items or text in another application and choose Import File, Import Text, or
Import URL from the EagleFiler section of the Services menu (inside application menu).
You can assign the keyboard shortcuts for the services in the Keyboard pane in System
Preferences or using Service Manager14 or Service Scrubber15.

• Run an AppleScript such as:

tell application "EagleFiler"
tell library document 1

import files {POSIX file "/Users/mjt/Desktop/Foo"}
import URLs {"http://www.apple.com", "http://c-command.com"}

end tell
end tell

In all cases, the data is copied into the EagleFiler library (as with iPhoto). EagleFiler automatically
detects duplicate files so that only one copy of each document is stored in the library.

If more than one library is open (and you didn’t drag into a specific browser window), EagleFiler
assumes that you meant to import into the current library (the one with the frontmost window).
If no library is open, EagleFiler will show a dialog asking you to open one; then you can click the
Import button to import the files into that library.

3.3 Don’t Make Changes While Importing

It can take a few seconds (or minutes, for large mailboxes) to import a file into EagleFiler. You
should not make any changes to the files being imported during this time. Doing so could cause
EagleFiler to copy the file in an inconsistent state. This also applies to mailboxes. For example,
do not move messages into or out of an Apple Mail mailbox while that mailbox is being imported.

14http://www.blacktree.com/apps/servicemanager/index.html
15http://www.petermaurer.de/nasi.php?section=servicescrubber
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3.4 Writing Capture Scripts

You can add support for capturing from additional applications by adding capture scripts to the
folder:

/Users/<username>/Library/Application Support/EagleFiler/Capture Scripts/

A capture script is an AppleScript saved in text format. The name of the file is of the form
<bundle identifier>.applescript, e.g. com.apple.Safari.applescript. You can determine
an application’s bundle identifier by finding the CFBundleIdentifier in the Info.plist file inside
the application’s package (which you can open using the Show Package Contents command
when Control-clicking on the application).

The script should have a handler called capture that returns a list of AppleScript records. For
example, the NetNewsWire capture script looks like:

on capture()
tell application "NetNewsWire"

set tabIndex to index of selected tab
if tabIndex is 0 then

if exists selectedHeadline then
set theURL to URL of selectedHeadline

else
return {{|error|:"No URL is available to be captured."}}

end if
else

set theURLs to URLs of tabs
set theURL to item (tabIndex + 1) of theURLs

end if
end tell
return {{|url|:theURL}}

end capture

Each record in the list should have a |url| key (for a remote http URL) or a |path| key (for a
full POSIX path). If no items are available for capture, the script can return the empty list, or it
can return a record with a |error| key that provides an application-specific error message.

The capture script for the Finder demonstrates how to capture multiple items at once:

on capture()
tell application "Finder"

set theSelection to selection as list
set theResult to {}
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repeat with theFile in theSelection
set theFile to theFile as alias
copy {|path|:POSIX path of theFile} to end of theResult

end repeat
return theResult

end tell
end capture

If the script creates a temporary file for the capture, it can include a |deleteWhenDone| key with
value true so that EagleFiler will delete the temporary file after it has finished importing the file.

4 Browser Windows

Each browser window contains a source list, a records list, a record viewer, and a toolbar. Drag
the split bars to resize the different portions of the window. Double-click a split bar to collapse it
entirely. Hold down the Option key while dragging a split bar to grow or shrink the window as you
drag.

4.1 Source List

Drag files here to import them. Drag to re-arrange files and folders in the library. The top-level
sources are:

Library

All the records in the library, organized the same way as the library’s Files folder in the
Finder.

Recently Added

The last 25 records that were added to the library.

Recently Modified

The last 25 records that were modified.

Tags

Select a tag source to view the records with that tag. You can also drag records onto a tag
source to assign that tag to them. Please note, however, that deleting a record from a tag
source deletes the record; it does not unassign the tag.

Unfiled

Files that are at the top level of the library, e.g. ones that are not in a named folder.
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Trash

The records that have been deleted from the library, but which are still available until you
empty the trash. This corresponds to the library’s Trash folder in the Finder.

You can select more than one source at a time to view all their contents at once. You can type the
first few letters of a source’s name to select it.

4.2 Records List

The records list shows the contents of the selected source(s). The columns are:

Tags

The abbreviations for the assigned tags.

Count

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Icon

An icon that shows the record’s type.

Title

The subject of a message or title of a document.

From

The sender of a message or author of a document.

To

The recipient of a message or document.

Date

The date the record was modified.

Date Added

The date the record was added to the library.

Size

The amount of disk space used by the record.

File

The name of the file containing the record.

Kind

The type of the record.
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Label

The Finder label of the record’s file.

Container

The name of the folder or mailbox that the record is inside.

You can type the first few letters of a record’s title to select it. Click the 5 to choose which columns
are visible. Double-clicking a record in the list is equivalent to choosing Open in External Viewer.

4.3 Record Viewer

The record viewer shows the contents of the selected record. It is read-only; to edit the record, use
Open in External Viewer.

4.4 Searching

The search box lets you filter the records of the selected sources to display only those records that
match the search criteria. Five different locations may be searched:

Anywhere

Searches the contents of the records, as well as the Title, From, To, Cc, attachment names,
and notes. This is an indexed word search that uses the following syntax:

"

Opening and closing delimiter for phrase-based searching.

(, )
Opening and closing delimiters for logical grouping.

!, NOT
Boolean NOT.

&, AND
Boolean AND. The <space> character also represents a Boolean AND.

|

Boolean inclusive OR.

*

Wildcard for prefix or suffix. Ignored in phrase-based searches. To search for a partial
word, use two *’s, e.g. *ant* will find ant, repellant, anthem, and words with ant in
the middle.

From

This is an exact search that examines both the names and addresses.
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To/Cc

This is an exact search that examines both the names and addresses.

Title

This is an exact search for record titles and message subjects.

Notes

This is an indexed word search (as above) of the notes of the displayed records.

5 Menus

5.1 The EagleFiler Menu

5.1.1 About EagleFiler

The About EagleFiler window shows the credits, as well as download and support information.

You can always download the latest version of EagleFiler from the EagleFiler Web site16.

Questions about EagleFiler may be sent to eaglefiler@c-command.com17. I’m always looking to
improve EagleFiler, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of EagleFiler, you can use the Software Update
feature or subscribe to the EagleFiler News mailing list18. The traffic on this list is very low, only
one message per new version of EagleFiler.

The EagleFiler RSS feed19 contains update notices and other EagleFiler news.

The EagleFiler forum20 is the place to talk with other EagleFiler users, share tips and tricks, and
ask questions.

5.1.2 Software Update

Click the Check Now button, and EagleFiler will tell you whether a newer version is available for
download. By default, EagleFiler will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

16http://c-command.com/eaglefiler/
17mailto:eaglefiler@c-command.com
18http://c-command.com/eaglefiler/support
19http://c-command.com/blog/category/eaglefiler/feed
20http://c-command.com/forums/forumdisplay.php?f=7
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If a new version is available, EagleFiler will tell you what’s new in that version. Click Download
to have EagleFiler download the .dmg file for the new version to your Internet downloads folder.
Click Download & Install to have it download the .dmg and then update the installed EagleFiler
application to the new version.

To check for a new version, EagleFiler contacts a Web server at dreamhost.com. EagleFiler trans-
mits the following information to the server: the name of the product (EagleFiler) and its version,
the version of Mac OS X, whether EagleFiler is registered, and the name of the current language.
This information is used to guide future development. No personal information is transmitted.

5.1.3 Purchase

This window lets you buy EagleFiler. If you’ve already purchased EagleFiler but it’s running in
demo mode, you can you enter your name and serial number to personalize your copy of EagleFiler
and remove the demo limitations.

EagleFiler has a free trial period that lasts for 30 days or 7 launches, whichever is longer. To use
EagleFiler beyond the demo period, you must purchase it. This entitles you to free updates and
support.

To purchase, choose Purchase. . . from the EagleFiler menu. You can use the Purchase button
to enter the online store.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. If you need to re-
install EagleFiler, you can simply re-enter your name and serial number and click Personalize;
there’s no need to purchase again.

If you purchased EagleFiler but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up
your order information.

A license for EagleFiler is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your PowerBook; you can then use it on either machine, provided that no one is
using it on the other machine.

5.2 The File Menu

5.2.1 New Library. . .

Creates a new library. Each library is a folder containing a Files folder, a Notes folder, and a
.eflibrary file. Double-click the .eflibrary file to open the library in EagleFiler. You can move
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the library folder around in the Finder (when it isn’t open in EagleFiler), but do not modify its
contents.

5.2.2 New Folder. . .

Creates a new folder in the source list of current library.

5.2.3 New Rich Text File

Creates a new RTFD file inside the selected source using the title and contents that you enter.

5.2.4 New Browser Window

Creates an additional browser window for viewing the contents of the current library.

5.2.5 Open Library. . .

Opens a .eflibrary file.

5.2.6 Import URL(s). . .

Opens a sheet for importing one or more URLs into the current library as Web archives. The text
box will be pre-filled with the contents of the clipboard.

5.2.7 Import File(s). . .

Opens a dialog that lets you choose one or more files or folders to be imported into the current
library.

5.2.8 Export. . .

Opens a dialog that lets you choose a folder to which the selected records will be exported.
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5.2.9 Empty Trash. . .

Empties the trash of the current library.

5.3 The Edit Menu

5.3.1 Undo/Redo

Most actions in EagleFiler can be undone and redone, and EagleFiler supports multiple levels of
undo. When you close a library or empty the trash, EagleFiler clears the list of undoable actions
for that library.

5.3.2 Copy

Copies the selected text, the titles of the selected records or sources, or the names of the selected
tags.

5.3.3 Copy URL

Copies a x-eaglefiler URL to the clipboard for each selected record. Opening the URL will
launch EagleFiler, open the library, and select the record so that its contents are shown in the
viewer.

If you move the library folder in the Finder, previously copied x-eaglefiler URLs for that library
will no longer work.

5.3.4 Copy Source URL

Copies the original http URLs for the selected Web Archive records. For other kinds of records,
copies file URLs for the files in the library.
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5.4 The View Menu

5.4.1 Message . Raw Source

If this is checked, the viewer will show the raw RFC-82221 source for e-mail messages. If it’s
unchecked, the viewer will instead show the Subject, From, Date, To, and body of the message.

5.4.2 Message . Plain Text

If this is checked, EagleFiler will show all e-mail messages in plain text format. For HTML-only
messages, a plain text representation will be created. If this is unchecked, HTML messages will be
shown using rich text and plain text messages will be shown in plain text.

5.4.3 Previous/Next Record

These commands select the previous or next record in the record list. This lets you change which
record is being viewed while the viewer pane has keyboard focus.

When the records list or the record viewer has keyboard focus, you can type Spacebar or Shift-
Spacebar to select the next or previous record.

5.4.4 Select Source

If you have a folder or mailbox selected in the record list, this command reveals and selects it in
the source list. Otherwise, the container of the selected record is selected in the source list.

For example, if the Library source is selected, you can use the search box to enter the name of
the folder that you want to view, select it in the record list, and then choose Select Source. This
is often quicker than expanding the various folders inside the Library source to find the one you
want.

5.4.5 Open in External Viewer

This opens the selected records in a specialized viewer application such as Preview, Safari, or Mail.
If a search is in effect, EagleFiler passes the search string to the external viewer so that it can show
you the matches in the document.

Double-clicking a record is a shortcut for choosing this command from the menu.
21http://www.ietf.org/rfc/rfc0822.txt
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5.4.6 Open in New Window

This opens a new browser window in EagleFiler to view the selected records.

5.5 The Record Menu

5.5.1 Mark Unread/Read

Add (or remove) the “unread” tag to the selected records.

5.5.2 Flag/Unflag

Add (or remove) the “flagged” tag to the selected records.

5.5.3 Show Inspector

This window lets you view and edit the properties of the selected records.

File Properties

This shows the file’s name, kind, size, and dates, as well as EagleFiler metadata such as the
title, from, and to.

If a record doesn’t have a title and you haven’t set one manually, EagleFiler will use the
filename (without the extension) as the title, and the title will stay in sync with the filename
if you rename it.

Label

This is the Finder label of the file. In EagleFiler, the label is shown as the background color
in the records list and also in the Label column. E-mail messages are stored as mailboxes,
not as individual files, so all the messages in the mailbox share the mailbox file’s label.

Tags

This shows the tags assigned to the record. You may find it more convenient to create and
assign tags by typing them in the text field than by using the Show Tags command.

Notes

Notes support rich text, clickable links, embedded graphics, tables, etc. Most of the commands
for editing notes are in the Format menu. As a shortcut, you can type Option-Tab to start
a bulleted list or Option-Shift-Tab to dedent the current list item.
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5.5.4 Show Tags

This window shows a list of tags for the current library. The columns are:

√

The box is checked if all of the selected records in the browser window have this tag. It shows
a - sign if some (but not all) of the selected records have the tag. It is disabled if no records
are selected.

•
The abbreviation (if any) for the tag. Abbreviations are shown in the Tags column of
the records list; for example, the “unread” tag is shown as a blue •. Double-click on an
abbreviation to edit it. The abbreviation can be composed of ordinary letters, or of special
symbols that you access using the Characters button in the toolbar.

Name

The name of the tag. Double-click on a name to edit it. (The names of built-in tags such as
“unread” cannot be edited.) Each tag must have a unique name.

You can give the tags palette keyboard focus by:

• Clicking in its title bar.

• Choosing Show Tags from the Record menu.

• Clicking the Tags button in the toolbar of a browser window.

• Editing an abbreviation or name.

Once the tags palette has keyboard focus, you can:

• Type the first few letters of a tag’s name to select it in the list.

• Press the spacebar to toggle whether the selected records in the browser window have the
selected tags. This is like checking or unchecking the boxes of all the selected tags at once.

• Click the Colors button in the toolbar. Then choose a new color for the selected tag(s) and
abbreviation(s).

5.5.5 Verify

This checks the selected records and their notes to make sure that the files are not damaged.
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5.5.6 Merge Mailboxes

This merges the selected mailboxes into a single mailbox file with the name and location of the
oldest mailbox in the selection. The tags and notes of the messages are preserved. The original
mailboxes are then moved to the trash.

5.5.7 Open Source URL

With a Web archive record selected, this opens the (live, not archived) Web page in your Web
browser.

5.5.8 Open in del.icio.us

This opens a Web archive’s URL in the del.icio.us22 social bookmarking site to help you find related
pages.

5.5.9 Reveal in Finder

This shows the selected records in the Finder. If you have Path Finder23 running, the files will be
revealed in it instead.

5.5.10 Reply to Message

This lets you reply to a message in your default e-mail program.

5.6 The Window Menu

5.6.1 Activity Viewer

EagleFiler can do many operations—such as adding files and URLs to the library, indexing,
verifying—in the background. This window shows a list of the tasks that EagleFiler is currently
working on for each library.

22http://del.icio.us
23http://www.cocoatech.com
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5.6.2 Drop Pad

You can drag files onto the Drop Pad to import them into the current library. The current library
is the library whose browser window is in the front. You can use the pop-up menu on the Drop Pad
to change the current library (without introducing window clutter). The Drop Pad also provides
information about whether EagleFiler can capture from the current application.

5.6.3 Errors

This window shows a list of errors that have occurred since you launched EagleFiler.

5.7 The Help Menu

This menu provides access to the full EagleFiler documentation (in Apple Help or PDF format) as
well as a link to the technical support Web site.

5.8 The Dock Menu

The Capture From <Application> command is equivalent to pressing the capture key.

6 Preferences

6.1 Capture Key

You can always import into EagleFiler using Import URL(s). . ., Import File(s). . ., or drag and drop.
However, if you are already viewing the information that you want import in another application,
it’s much easier to just press the capture key. When you press the capture key (F1 by default—
notebook users may also need to hold the fn key), EagleFiler automatically determines what you’re
currently viewing and imports it into the current library. EagleFiler will show a red circle (like a
VCR’s Record button) in its Dock icon, and it will play a camera sound. This lets you know that
the capture has started. When it’s finished, if you have Growl24 installed, you’ll see a notification
bubble.

EagleFiler can capture from these applications:

BBEdit
24http://growl.info
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Captures the file of the first document of the front window.

Camino

Captures the URL of the current tab.

Cocoalicious

Captures the URLs of the selected posts.

Finder

Captures the selected files in the front window.

iCab

Captures the URL of the front window.

Mail

Captures the selected mailboxes in the front viewer window. Tags and notes from MailTags25

are preserved. If you try to capture while Mail is already fetching mail or moving messages,
EagleFiler will abort the capture.

Mailsmith

Captures the selected mailboxes.

Microsoft Word

Captures the file of the front window.

Netflix Freak

Captures the URLs of the selected movies.

NetNewsWire

Captures the URL of the current tab, or the URL of the selected headline (if no tab is
selected).

OmniWeb

Captures the URL of the current tab.

Path Finder

Captures the selected files in the front window.

Safari

Captures the URL of the current tab.

SubEthaEdit

Captures the file of the front window.
25http://www.indev.ca/MailTags.html

24

http://www.caminobrowser.org
http://www.scifihifi.com/cocoalicious/
http://www.apple.com/macosx/features/finder/
http://www.icab.de
http://www.apple.com/macosx/features/mail/
http://www.indev.ca/MailTags.html
http://www.barebones.com/products/mailsmith/
http://www.microsoft.com/mac/products/word2004/word2004.aspx?pid=word2004
http://www.thelittleappfactory.com/application.php?app=Netflix%20Freak
http://ranchero.com/netnewswire/
http://www.omnigroup.com/applications/omniweb/
http://www.cocoatech.com
http://www.apple.com/macosx/features/safari/
http://www.codingmonkeys.de/subethaedit/


TextEdit

Captures the file of the front window.

TextWrangler

Captures the file of the first document of the front window.

Vienna

Captures the URL of the last selected post.

In some cases, EagleFiler captures the information directly from the application’s internal storage.
Thus, you should not modify it while the capture is in progress. For example, do not check for new
mail or move messages between mailboxes while capturing from Mail. If you are capturing from
the Finder or Path Finder, do not modify the files during the capture.

EagleFiler must be running in order for the capture key to work. Thus, you may wish to add
EagleFiler to your Login Items in the Accounts pane of System Preferences.

6.2 Fonts

Sources

Used in the source list in browser windows.

Lists

Used in the records list in browser windows and in the list of tags in the tags inspector.

Rich text

Used for e-mail header information, HTML messages, and as the default font for notes.

Plain text

Used for plain text e-mail messages.

The fonts for Web archives are mostly controlled by the Web archives themselves. The default font
families and sizes can be controlled using Safari’s preferences.

6.3 Quoted Text Colors

EagleFiler colors plain text e-mail messages according to the number of quote characters at the
start of each line. The pop-down menu lets you choose a preset coloring scheme.
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7 Frequently Asked Questions

7.1 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number.
Launch EagleFiler and choose Purchase from the EagleFiler menu. Then click the Lost Your
Serial Number? button.

8 Legal Stuff

EagleFiler and this manual are copyright c© 2002–2006 by Michael J. Tsai26. All rights reserved.

Please distribute the unmodified EagleFiler-1.0.dmg file on the Web, LANs, compilation CD-
ROMs, etc. Please do not charge for it (beyond a reasonable cost for media), or distribute the
contents of the image file in isolation. Do not distribute your serial number.

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

EagleFiler is a trademark of Michael Tsai. Mac is a registered trademark of Apple Computer. All
other products mentioned are trademarks of their respective owners.

The following open-source components are used in EagleFiler:

Regular expression support is provided by the PCRE27 library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

Thanks to Allan Odgaard for some code snippets that are used in the Software Update installer.

libffi28: Copyright c© 1996-2003 Red Hat, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

26mailto:mjt@c-command.com
27http://www.pcre.org
28http://sourceware.org/libffi/
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The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL CYGNUS SOLUTIONS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

PyObjC29 - Copyright 2002, 2003 - Bill Bumgarner, Ronald Oussoren, Steve Majewski, Lele Gaifax,
et.al.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Python30:

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSF”),
and the Individual or Organization (“Licensee”) accessing and otherwise using this
software (“Python”) in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise
use Python alone or in any derivative version, provided, however, that PSF’s License
Agreement and PSF’s notice of copyright, i.e., “Copyright c© 2001, 2002, 2003, 2004,
2005, 2006 Python Software Foundation; All Rights Reserved” are retained in Python
alone or in any derivative version prepared by Licensee.

29http://pyobjc.sourceforge.net/
30http://www.python.org/
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3. In the event Licensee prepares a derivative work that is based on or incorporates Python
or any part thereof, and wants to make the derivative work available to others as pro-
vided herein, then Licensee hereby agrees to include in any such work a brief summary
of the changes made to Python.

4. PSF is making Python available to Licensee on an “AS IS” basis. PSF MAKES NO
REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF
EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY
REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT IN-
FRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS
AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of agency,
partnership, or joint venture between PSF and Licensee. This License Agreement does
not grant permission to use PSF trademarks or trade name in a trademark sense to
endorse or promote products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by the
terms and conditions of this License Agreement.

9 Version History

1.0—October 13, 2006

• First public release.
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